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Agenda

e Logistics

e Introduction

e The environment

e Concepts & components

e Model exploration

e Modify a competitive dynamics model
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Setup

e Download the course material folder and unzip to a convenient
location

— Source: http://ventanasystems.com/conference , or use the
conference schedule page

— Choose a location you control, i.e. not locked by your operating
system

o Install Ventity 4 from http://Ventity.biz/download
— Licenses are unlocked through the end of September



http://ventanasystems.com/conference
http://ventity.biz/download
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Goals
Mechanics Modeling Concepts
e Environment e Model-data separation
e Diagramming o Entities
e Equations — Types vs. instances
o Units — Design - what goes where?
e Run control ~ State focus

— Attributes

e Run naming

o Entity initialization data
e Charts/tables

e Slider controls

e Entity picker

e Time series data

e Attributes
 References

e Collections & aggregates
e Actions & triggers

e Relationship entities
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Orientation

e Diagramming e Output

e Equations e Charting

e Units e Tracing
e Picking

e Run control

e Naming

e Entity Initialization Data e Macros
e GIS
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Console
[e8/3/2018 12:42:38: Loaded model Supply Chain 7 from C:\Users\Fid\OneDrive - Ventana Systems, Inc\ISDC - 2018\Workshops\Ventity\Supply Chain 7\Supply Chain 7.vmdl.

|es/03/2018 12:43:38: Completed running model Supply Chain 7 with 2 warnings.

la8/03/2018 12:43:38: Scenario Run 1 construction took 0:60:06.0610601 and execution took 89:@0:08.0290017.

|e8/03/2018 12:43:38: Warning in model Supply Chain 7 : Unable to reference Entity Type [supplychainlevel] from level [: i retailer]] using Attribute [Customer]
|e8/03/2018 12:43:38: Warning in model Supply Chain 7 : Unable to reference Entity Type [supplychainlevel] from supplychainlevel [supplychainlevel[factory]] using Attribute [Supplier]

Console & Error List

| console | ErorList

Ready | Erorsi0 | Wamings:2 |
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ENTITIES &
WHAT GOES WHERE?



VENTANA

Principles
e Everything in an Entitytype shares a common level of detail

e Variables belong in the Entitytype with the required level of
detail

e Global parameters can go in the Model (or another singleton)
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1. Classic Bass Model

Potential Adopters % g Adopters
Adoptlon Rate
Adoptlon from /
Advertising
‘/ Total Population
Adoption from
Advertising Effectiveness Word of Moth

\/Adoption Fraction

Contact Rate
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2. ... with multiple firms

\/ .

Potential Adopters

v 2

Market

Contact Rate

Total Populatio

7
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Adoption Rate
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Adoption from
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3. ... multiple segments & firms

Potential Adopters X P Adopters
Adoption Rate

\»Adoption from
Advertising

s ™

Adoption from
Word of Mouth

Adoption Fraction
_/

Advertising Effectiveness
Segments
N |

Contact Rate
\

Total Population |

\_ J _ y
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Collection Hierarchy

CustomerBase [ ]
(summary of all entities)

\

CustomerBase [Firm] CustomerBase [Segment]
(summary by Firm attribute) (summary by Segment attribute)
FirmA, FirmB Segl, Seg2

\/

Individual Fentities: CustomerBase [ Firm, Segment ]
FirmA,Segl  FirmB,Segl  FirmA,Seg2  FirmB,Seg2

12
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Implementation

J O-Segment x| 7 J O-Cusb:merBase x| bt J OFirm x|
% @, | Segment--- SegmentiD | % @, | CustomerBase--- Firm Segment | % @ | Firm--- FirmiD |
Firm> Segment
SegmentlD
FirmID »
Segment Customer
Share Init Residence Time

/Y Segment
Potential
Patential d Customers

Market Customers

Population

Copyright © 2018 Ventana Systems, Inc.

Init Customers

__/
=]

Adopting

\

Ad Conversions

Patential
Customer
Prevalence

Ventana is a registered trademark and a registered service mark of Ventana Systems, Inc.

» Customers
Firm ?
Success
Rate
Word of I'u'!cnulh
Conversions Segment

S~ Contact Rate

(

Effect of Saturation
Segment
*\\__4 Potential
Customer
Prevalence

Ad Effectiveness

Success Rate

CustomerBase by )
Fim Customers

Customers

13
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1-2 Data

e There are 2 kinds of “data”:

1. Entity Initialization Data, used to set up the model entities (similar
to Vensim .cin files)

2. Time Series Data, used for comparison or driving model variables

14



VENTANA 1. Entity Initialization Data

CustomerBase Firm
Tme CalendarTime  FirmID  Success Rate T
v W 0 FirmA 0,009
2 M 0 Firme 0.011
3] O 07/24/2014  NewFirm 0.015
CustomerBase Firm
Time  CalendarTme Firm  Segment | Customers
b1 m 0 FirmA  Segmentl
2 E 0 FirmB  Segmentl
3 E 0 FirmA  Segment2
4 m 0| customerBase Firm ket Model Segment
0 D m Time  CalendarTime  SegmentlD  Potential Customers | Segment Share Init
& [ i W 0 Segment1 0,25
2 E 0 Segment2 0.75
+ [
Copyright © 2018 Ventana Systems, Inc.  Ventana i a registered trademark and {
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1a. Varying the data selection

e Sources and Sets

e Run Control and data

e On-the-fly data selection
o Entity picking

] Entity Initialization D...

=} Data Sources

@ |=| 1firm 1seg
O 5| 2firm 2seg

O |E]| 3 firm 2seg

O) i File: 3 firm 2.

.3 Data Sets
Run Control

16
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1b. Sources & Sets | . Time Series Data

=y Data Sources
+ |4 Data Sets

e A"Source” is a single file @ [i® No Data
e A“Set” loads multiple Sources " Entity Initislzation Datz
] ] v =} Data Sources
e As In Vensim, order matters: the last set O [F 1fim 1:eg
loaded wins in the event of a conflict O [E] 2firm 2seq

@® || 3 firm 2 seg
O dmm File: 3 firm 2 seg.xlsx
O [E| Firma mare effective
+ |4 Datasets
O [ No Data
» O[5 3% 2 +FirmA eff
=] 3 firm 2 seq
|_| FirmA more effective

17
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1c. The Run Control

e Run Control settings ® i tovate L™/ |

- | Entity Initizlization Data
determine which data sources " OE e
or sets to use O 2
l:)@ File: 3 firm 2 seg.xdsx

(@) IJ Firma more effective
+  [d Datasets

Q & NoData
+ OE 3x 2 +FirmA eff
|_| 3 firm 2 seg SEng.nt
El FirmA Fract Potential
|£| FirmA& more effective e
=] Run Contral
% Results (2) N Run Contral
b [ Analysis = = =
- ool | |i= L) | e || Al MNone Inw
[7] Save Lists WL @ lv
TR s
E H_Epulr_ . Enabled  Mame Entity Initislization Data | Tir
k- 1L IS AT
V|  base Use active dataset Ls
Entity Type 3 v better FirmA * 3 x 2 + FirmA eff il

[ CnstomerRase
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1c. On-the-fly selection

e If “use active dataset” is
selected in the Run Control,
the radio button in the Entity
Initialization Data section
controls the active data

+ |4 DataSets

@) | NoData

Entity Initialization Data
»  [E} Data Sources

O [E] 1frm1seg

O 5] 2firm2seg

® [E] 3 firm 2 5eq

(9 ile: 3 firm 2 seqg.ulsx
v {3l DataSe
O & NoData

- Q'Li_i;;x 2 +FirmA

| Firm | Segme

4

|_| 3 firm 2 seg SEng.'nt
= e . Potentiasl ————
|| FirmA more effectiv e
= Run Contral
= Results (2) Run Contr
b Analysis
4 Al Mone Inve
Save Lists —
Reports

Ernabled  Mame Entity Initialization Data  Tin

AR \ieyalizatinne

2 | base

Use active dataset * s
Entitv Tvpe

19
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1d. Selecting data visibility

e Initialization data
determines which
entities exist

e The Entity Picker selects
which entities are visible

e The Results pane selects
which runs are visible

O |E] 1firm 1seg

e - T .
O E| 2firm 2seg Results
® |_| 3 firm 2 seqg
O @ File: 3 firm 2seg.xsy | L4 | | & @ |+ |& |3 | le L |22
O [E] Firma mare effective
- (4 Data Sets
I‘j:f" E Ne Data Visible Loaded Mame Date Fun File
* IS 3x 2 +FirmA EH
= b 1 07222020 14:05:11 =aa|
|Z| 3firm2seq v =5 122 B H
=] Firma more effec v ¥  base 07/22/2020 14:05:37 /m A
=] Run Control
= Results (2)
b Analysis
Save Lists - =
Reports
k ARy Viznalizatinne CUStDmEI'S
Entity Type 160000
- = CustomerBase
, 140000
= Firm
V| =" Firma
- 120000
* =" FirmB
-yl wiEi
¥ 7| MewFirm {00000
k J Segment .
- ustomerBase[Segmen =
W CustomerBiase[s f]
S anoon
- -f Segment O
-yl
¥ 7| Laggers SO0
v 7" Leaders
(= Firm 40000
3 \f Segment
20000
0
2016 Juby 2017 July 2015 July 2019 July
2017 January 2018 January 2019 January 2020 Jar
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2. Time Series Data

e Everything about Sources, Sets and selection applies

e Formatting the data for import
e Mapping
e Using data

21
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2a. Formatting Data

o Easiest to use the Help as a cookbook

E? Ventity™ Help

e = & /

Hide Back Forward Home Prirt 0O

Corterts  |ndex Search Favortes

Welcane
@ Examples
= @ Defining Entity Tupes
Create a New Model
Irmpart Entity Topes
Irmparting Yenzimn Models
@ Create a Mew Entity Tupe
Cuztomn Macros
= [[]) Data Entities
Data Sources
Dats Entities and Maps
tadel Encryption
@ Initializing E rlities
@ Simulating
@ Examining Fesults
@ The Yentity WWork space
@ Further Infarmation

Navigation: Defining Entity Types > Data Entities >

Data Sources

Excel files

A data source is a Microsoft® Excel spreadsheet or workbook containing data associated with particular times. Typically this means time
figures over a 6 year pariod), but it can also mean a single data point (the population in September, 2012). Data files can be stored anyw
subfolder of the model folder.

A single worksheet or tab will generally contain information for many entities, but_all the entities on a single worksheet or tab must be of
the name of the entity type. If you have more than one sheet for an entity type (say, Platypus), the sheets should be named Platypus, Pl
text after the underscore does not have to be A, B, C; it can be whatever you like. The requirement is that each sheet name begins with
and the further text to make the name unique.

The worksheet may be organized in any one of four common layouts. Ventity automatically detects which one is being used, based on k
as follows. The examples shown are for variables Weight and Age of entity type Platypus having key attribute PlatypusID.

Layout Description Requirements Example
Tidy Each_rnw specifies an entity lll-'irst row c?ntains keyword A B c D E
Egﬂ;m& each column, a ngﬁ:il';ﬁ;g;‘;:g o key 1 PlatypusiD DateTime Weight Age
attributes 2 Albert 0 30 14
3 Albert 1 35 15
4 |Beatrice 0 28 12

22
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2b. Creating a Mapping

|| Lidid CHULY | ypes

e Add the file SyntheticData.xlIsx T haee

pm S Add Data File...
. - [d patasets TaTE
e Detect Source Entity Types @l tonse
- [C7] Entity Initizlization Data
|
e Create Data Entity Types
Time Series Data Mapping - File: SyntheticData, xlsx

Mapping M Series Data D iption:

applng. am SyntheticData. xisx ie Series Data Description | | _

syntheticdatrrappm | {[3] Detect Source Entity Types | 1™ Create Data Entity Types

File: SyntheticData.xlsx - , ’

Source Entity Type: Aht} Lﬁl L @. & E @ Data Enfity TYPe! | galact Data Entity Type = @, A..la}f ;?.

customerbase CustomerbaseData

IR All Mone Invert

customerbase
ﬁzl_r::;e 15_3;2:& ;I_l;t;;pnlahnn ¢$§;Egahnn Ehcu_lli_ltrsce guegg;ﬁun 15_3:2:& Measurement Dats Mame  Data Type Dats Key
¥ | Firm Key Firm
Segment Key Segment
True Custo... Variable Straight True Custo. ..
Data Custo... Variable Straight Data Custo...

23
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2c¢. Viewing Data

e Now you have a data entity containing the data variables.

e There’s no diagram (though you could drag variables from the
inspector to create one)

e You can drop charts onto the diagram for viewing

r x (O Model CustomerbaseData X ~ | Entity Type Inspector X

Entity T .
niity Types @ @ CustomerbaseData --- Firm Segment X CustomerbaseData

(O customerBase

8Fifm | | VoOEAMBE
Market Auilizry Dat Lookup Link A Not:
O Model aiizry stz Lookuy in Label - I_I E}]Dafa(m{ome’s

O segment e Bl | Data Customers Raw
Components B True Customers
Macros / @ o o / R True Customers Raw
Data Entity Types

Data Customers Data Customers Raw

@) CustomerbaseData
Time Series Data

+ 5 Data Sources ... m
+ (®) = File: Synthetichata.dsx 300000 300000 £
o‘

syntheticdataMapping

[ 4
- |4l DataSets 200000 200000
O i@ No Data M
@ L 100000 100000 “
3 Entity Initialization Data
& Run Control
% Results (1) o 0
2017 2018 2019 2020 2017 20msa 2019 2020
3 Analysis . Time
Save Lists Time . -

24
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e Drag the data
from the
inspector onto
a chart with the
corresponding
model variable

2d. Creating a Comparison

O Model CustomerbaseData O C x
222] @, | CustomerBase--- Firm Segment
Stock ) Auilary Loskup_. Link
Trigger
Firm Segment
Customer
Residence Time
Dropping
Segment
Potential » Customers
Customers Adopting
Ad Conversions Ward of Mouth
Conversions

Firm
Ad
Effectiveness

Effect of Prevalence

Label  ne=s

Firm
Word of
Mouth
Success R..

Segment
Contact Rate

Segment
Potential
Customer
Prevalence

Customers, Data Customers Raw

300000

ople

200000

e

100000

o

Adopting
2500
2000

peoplefday

2017

2017

L] [ 52

Imags

Mut-Shoer

2018

2018

Time

2019
Time

2019

2020

2020

b Entity Type Inspector

® CustomerbaseData
voodARTiE

Bl Dats Customers

FH: Data Customers Raw

M True Customers
Bl True Customers Raw

= NP

CustomerBase CustomerbaseData

25
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2e. Using the Data

A. Drag the data variable onto
the CustomerBase diagram

= = = A I C;z;gféifféﬁfé*j Mame: |Custnmer|::aseData
Bl ng ht-CIICk and edlt the Haw Cwner: |Cust-:nmerBase
Refe re n ce to m a tc h Fi r m a n d gztr'lctl:ne-i?l'rime Target Type: | CustomerbaseData

Conditions: | Attribute Key Value to Match

Segment iJ

C. Add an auxiliary to compute j‘
the Error as the difference Neme: [Eror

Owner: |CustcumerEase

between simulated =P| Customers Fim it [people

Word of

Customers and the data. o Mot O] constent f

Customers-CustomerbaseData.Data Customers Raw

26
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3. Add Financials to the Firm

e Price and revenue

e Firm profit

e Sum revenue by Firm

e Reference the collection from the Firm

27
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o Options

— Build from scratch

3a. Adding Firm profit & loss

— Import a component (recommended)

- [T Entity Types
v {0 CustomerBase

n

© Qrm Import
() Market
() Model
v (O segment
] Componants
F Mad Mew Component... f
~ [0 Dats lmport Compenents...
=1 v T -
I This PC Dynamic Cohorts
_ GOMGIS 2
- 3D Objects InfectionSeries3
Bl Desktop Macrol
5] Documents MacreComponentl “
* Downloads Project20
J*, Music Supply Chain &

Entity Type Inspector

O Firm ,

v O AR RS

Include

| Indude Component

Include Component

Component: | ProfitLoss

Prefix: |ProfitLoss

Cancel

Entity Type Inspector

o Firm ‘

1

Ma

&8 A MBS

in

Profitloss Main o,

=

Go to New
Diagram

28
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3b. Creating a Collection to Sum Customers

e Need a source for Units Sold
e Assume 1 item per customer per day
e Same price to all customers

Create an aggregate to sum
e So: need to know Sum(Customers) 99reg

customers

. . Agoregsts Atribute Link Label Nates
Create a new collection of CustomerBase by Firm 1 = LB

Model Overview a X
Entity Types ] o o o
() CustomerBag Key Attributes: | g  Sum o
[-] Customeq ~ Inspect 5 ST
[] Segment o o e
[] Customer Rename.
D Firm Delet Aggregate - CustomerBase[Firm].5um Customers
ElELE...
D Market Mame: |Sum Customers
8 I;"I::u:lel t Include Compenent... Owner: |Customergase[Fim]
eqgmen _
Companents Mew Collection... Mapping Attributes: Units: |I:'E':'I3|E
D profitloss Mew Action Base Type: |Cusb:umerBase

Aggregation Function: | Sum h
Target Variable: | Customers “

TE Ermrts s o e i e v



VENTANA A. Drag Sum Customers onto the Firm Profit &
Loss diagram

B. Edit the reference to match Firm to FirmID
3c. Using the Sum C. Write the equation for Units Sold
D. Right-click to add Units per Customer per Day

ProfitLoss
[] CustomerBase Price .
[Firr] ProfitLoss
Revenue
- [ S —
VOoEARE A @ 8 0
LUSIOmercase oy Profi
: rofitLoss
&y Sum Customers » 0 Fim o Units Sald
= Count Sum Customers a ProfitLoss
- o :
. — Gross Profit
» || Auxiliary - Firm.ProfitLoss Units Sold X
e |Cusb:umerEiase by Firm | Name: |Pr':-ﬁtLDss Uniits Sold |
Owner: |Firm | Owner: |Fir|T| |
Target Type: | CustomerBase[Firm] o Lnits: |unit|"day' |
Conditions: | Attribute Key Value to Match [ ] Constant
Firm FirmID : TTwm 4
CustomerBase by Firm.S5um Customers*Units per
Customer per Daw

Create Mew Stock "Units per Customer per Day”
- ( : Create Mew Auxiliary "Units per Customer per Day" ;O
Create Mew Attribute "Units per Customer per Day"
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4. Add Slider Controls & Charts

e Where should we put them?
— The Model entity is often convenient for top-level controls
— Detailed drill-down can live in other entities

e Slider variables must be Constants

e A slider affects all runs, unless “"Ignore First Run” = True
— This facilitates a nice treatment of base case vs. policy runs

31
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4a. Adding a Slider

e Drag onto diagram
Label = ||| [ |
e Right-click to edit LHE L | g [

e Choose the Bound Variable
o Edit settings as needed

It-Slider

Market Assumptions

segment Min Contact Rate: (1/day] Misc Al &
Leaders 1 y Mame Segment.Contact Rate_C1
Laagers 1 Bound Variable

Entity Type CustomerBase. Customer Residence Time <
CustomerBase. Customers

SliderCaption
e Firm.Ad Effectiveness

Predsion

Firm.Price
Auto Set Min/Max Values | Firm, Word of Mouth Success Rate
Minirmum Market. Population
Maximum Segment. Contact Rate p ~
e i e S T

32



VENTANA  4b. A possible layout

J OMDdE| X| (@) CustomerbaseData | OCusmmerBase | OFirm | OFirm-ProﬁtLoss Main | -] CustomerBase[Firm] |
=22 @ | Model--- Mo identifiers |
e UL
Stock ( ) Ay Looku Attribute Link Notes } i' - :| ORI
. Button [
Ehen Ime=  Enie
]
Market A ti Customers
300000
2 200000
Segment segment Min Contact Rate: (1/day) Max Input o
Main Leaders 1 & 20 3 100000 —
Laggers 1 - 20 2 _/—
o
2017 2015 2019 2020
Time
]
Adopting
- 2200
Firm Performance
2000
o
E 1500
2 1000
firm Min Ad Effectiveness: (fraction/day) Max Input 0
Firmé 1 = 1 0 500
FirmB -1 = 1 0 0 ——
NewFirm 4 = 1 o 2017 2018 2019 2020
Time
]
firm Min Word of Mouth Success Rate: (fraction) | Max Input Profitloss Operating Profit
FirmA 0.0025 e 0.04 0.009
FirmB 0.0025 e 0.04 0.01 300000
MewFirm 0.0025 " 0.04 0.02
::? 200000
el
T
100000 e —
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4c. Base vs. Policy Runs & “Ignore First Run”

e In the Run Control, use the o

FIR= I Yk Al  Mone  Invert
D u pl |Ca te b Utto n to Co py the Enabled r| Duplicate selected IEnﬁtg.-' Initizlization Data  Time Series Data | Save List gzilg%dar #I_;:_il?:
' Time
ba Se ru n, a nd re na m e the n ew | base |se active dataset lUse active dataset Mone (Saves Everything) v
w - ” - 3 vy policy IUse active dataset IUse active dataset Mone (Saves Everything) v
run “policy” (the new time
A\ n
range should match “"base”)
e For the Firm Performance Firm Performance
2000
- A\ = n =
sliders, set “"Ignore First Run
to True firm Min Ad Effectivenmesfimstinmidacd o tto. E —
FirmA 1 Misc allm
— 1 Mame Firm.Ad Effectiveness_(2
NewEirm 4 Bound Variable Firm.Ad Effectiveness
Entity Type firm
SliderCaption
Predision 5 |
firm Min Word of Mouth 5 Auto Set Min/Max Values True |
FirmA 0.0025 Mirirriurr
FirmB 0.0025 Macimum
NI;I.-:.Firm 0.0025 Ignore First Run True P 0
Background Color White

Enranrsund Calar

Blacle 0
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4d. Setting Base to a low-key style

e Run the model

e Select View>Data Styles

e Switch to the Data Styles pane

e Set the line style for "base” to something unobtrusive

BassArrayFinished5tep 4 - Beta 4.0 Lice B Edit Data Style [=]

View | Model Help
Model Overview 8 ), o Data Style

Entity Picker Marker

= Variables . . .
2 I@l Result , Variable Entity Color Style Thickness Visibility

I base a B 127, 127, 127 Dash 1
— ’

Units Manager

Error List Halli Data Style .

Style Chooser
Console

Task Progress
Equations »

Results

Diata Styles
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5. Add Firm Launch

e Where?
— The Model is convenient
— The Firm[] might be an alternative

— Putting it in the Firm is usually undesirable, unless Firms are
spawning more Firms (e.g., spinoffs)

e Parts needed
— An Action that creates a Firm
— A Trigger that fires the action

36
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5a. The Action

e Right-click the Model to make
a New Action

D Firm

Firm

o Edit the result to set the name,
type and quantity

Link

Trigger

() Firm-ProfitLoss Main

/\ Label

newFirm
FirmlD

L3

=

Ea

~
)

Ea

\_J Market
O Model
() segmen Inspect
l:-:umpu:unent Rename...
D profitlo
Delete...
Macros
Data Entity Include Component...
Custome - .
Time Series Mew Collection...
i.-;_E' Data So Mew Action u
o~ T . = O T T

[-] CustomerBase [Firm] A\ Create F x
otes [ ,-'I __, |
= Button
chen Image i Shder
Action Inspector x

A Create Firm

v O HA®BE

Mame: |Create Firm “ |

Owner: ||"-"|DE|E| |

Kind: |Create e

Create:

Quantity: \
1
“

Description:
{

Firm A

37
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5b. The Trigger

Drag a Trigger onto the Model
diagram

Create variables to flag the
event of a launch (a frequency
of .001/day works since there
are ~1500 days); you may
want to give the base and
policy runs the same random
seed in the Run Control

Set the Trigger condition to the
flag value

Set the Action to point to the
action created in previous step

(O Model x| @ CustomerbaseData
ER
-

B (D)
o | @ | Model ---

Stock ! ) Aunilizry

ustomerBase
Main

egment
Main

B

D CustomerBase

Mo identifiers

() Firm () Firm-ProfitL oss Main [+] CustomerBase [Firm]
Link A Label  Me=s [ ] |
- Button
Trigger Chart Im

Market Assumptions

segment Min Contact Rate: (1/day)
Leaders 1 .
Laggers 1

MutShids
Max Ir
20 53
20 2

Mame: |Firm Enters

[n] {n] n}
Firm Entry '
Owner: |Model
Frequency oFirm Enterso wner |
o p .0 Urits: | dml
I:| Constant
A RandomBernoulli (Firm Entry Freguency*Time Step)
] Time Step
Create Firm _
Trigger - Model. Create Firm x
Neme: |Creat Firm |
Owner: |M0de| |
Seq. Mo.: |1 =
When: | Period Start w

Trigger If:

Firm Enters>0

C

Action to Invoke:

< Create Firm D
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5¢. Viewing Firms

e The new firms are hard to spot on charts,
because they have no Customers

e They’re easier to find in the Entity Picker or data
ta bleS ProfitLoss Operating Profit

300000

70000

240000

210000

150000

150000

Fiday

120000

0000

AO00a

30000

1]

e

‘ ---- base FirmB : 154544.5814

2017 12/17/2017 2019 2020
Time

Entity Picker
Entity Type
- M CustomerBase
- \,r" Firm
! = Firma
! = FirmB
v 7" NewFirm
b \,r" Segment
v B CustomerBase [Firm]
v W CustomerBase [Segment]
- yf'. Segment
v 7" Laggers
v 7" Leaders
y CustomerbaseData
- q" Firrr
- &  FirmID
! = Firma
! = FirmB
v 7" NewFirm
W1 = firm_0001

i

| = firm_nooz2
W ! firm_0003
V| ! firm_poo4
W = firm_000S
| = firm_0oos
W ! firm_ooo7
Segment
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6. Why no customers?
Firm Segment Entry

e Newly-created firms aren’t active in any market Segments, i.e.
they have no CustomerBase entities associated with them.

e To fix this:

— A Firm can check the CustomerBase[Firm] subcollection to see
whether it's active in any segments

— If none, the Firm can run a Process List action to pick a Segment to
enter.

— The Firm messages the Segment to add a new CustomerBase entity
with matching Firm and Segment attributes.
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QOFirm x| O FirmProfit_oss Main

u] o

Chobse Segment

Trigger - Firm.Choose Segment

6a. The Firm entry trigger

[-] CustomerBase [Firm]

=

otes l -'I | | |
= Button e
Shan Im2c2  FiuirSier

[] CustomerBase

[Firm]

CustomerBase vVOoEAD:
by Firm <=
@] Sum Customers

Count

Mame: |Chl:u:|se Segment

Cwner: |Firrr|

Seq. Mo.: |1

When: | Period Start

Trigger If:

CustomerBase by Firm.Count = 0

Action to Invoke:

Add a Trigger to the
Firm

Drag
CustomerBase[Firm]
.count onto the
diagram

Set the trigger to
fire when count=0

Leave the action
blank (come back
and fill it in after we

create the action)
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¥
O Mar Inspect
! D Mog Rename...

6b. The Process List action +_Oseg e

+  [C7 Compon
(& Prof Include Component...
[ Macros

- 7 Data En Mew Collection...

e Create a new action in the Firm . © o Newhcton

o Set the Kind, Collection to Process and Sort -
A Choose Segment

vOHABE

Mame: |Chu:u:use Segment |

Owner: |FIITI'| |

Kind: | Process List «v

Collection to Process:

Segment [ h

Filter:

Sort | Ascending “ | By:
Random () h
S 42
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Create a Counter
stock and flow in
the action

Notice that,
because an action
is a discrete
event, the stock
and flow have the
same units

This stock exists
only in the action,
so it will count
the number of
iterations of the
Process List loop

6¢. Limiting entry to 1 segment

Counting

..

Mame: |Cu:uunﬁng

Owner: |Chl:u:|se Segment

Urits: |

From Stock: |

To Stock: | Counter

[] constant

Stock - Choose Segment. Counter
MName: |

Owner: |Chn:n:nse Segment

Units: ~|cmnl

Default |0
Initial
Value:

Description:

Inflows:

Counting

Set the
Process While
field to
Counter=0

Create a
trigger for
Create
CustomerBase
(we'll fill it in
later)

Fitter:

Sort | Ascending w | By

Random ()

Process While:

Cnunter=1

———)» Counter
ting

Create CustomerBase
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(O Segmen

6d. Creating the CustomerBase

Create a new action in the Segment

Name it, and set the Kind and Create type

Switch to the References tab and edit the Invoker
Change the type to Firm

Component
{B Profitlo
Macros

Data Entity
Customg
Time Series
5L Data 5o

Inspect

Rename...

Delete...
Include Component..,

Mew Collection...

+ @ (= File:

Mew Action

il

B C

Action Inspector r X

A Create Customer...

Action Inspector o X

A Create Customer...

= v O ulR s
vOHEABRE - ’
» o] Invoker <Segment>

Reference - Create CustomerBase. Invoker

Mame; |Invoker

D

- mn X

% A Create Customer ...
v ool A TS

v+ =] Invoker <Firm:
k=t | newCustomerBase <Cu...
b 5] Parent <Segment:

Name: |Create CustomerBase ‘
» o] newCustomerBase <Cu...

Cwner: |Create CustomerBaze

Chwner: | Segment |

Kind: | Create * ~
Create: |CustomerBase ‘v

Cuantity:

b -E Parent <Segment=

Target Type: | Firm _

Conditions:
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6e. Define the new CustomerBase’s attributes

 You can drag the invoker and parent ids from the inspector, or

type them and use the right-click-draw-arrow method to add
them to the diagram x

MName: |nEWCustomerEiase #Firm |

Cwner: |Create CustomerBaze |
Invoker newCustomerBas
FirmlD Firm Refers to: | Firm

Key

Mew Value: | Inmvoker.FirmID «

Parent newCustomerBas
SegmentlD Segment

newCustomerBasee
Customers Marme: |newCustc:merEase sSegment |

Cwner: |Create CustomerBase |

Refers to: | Seament

Key

Mew Value: Parent.SsegmentID “
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6f. Define the initial Customers stock

e This is a little tricky — if we add a nonzero numerical value, we're creating
new people

o If we use 0, there’s no word of mouth for the new company

 Instead, we can seed the market with a small fraction of the Potential
Customer stock

e We can do this by creating a cross-entity flow:

2 Units per Customer per Day

i Word of Mouth Success Rate Parent
: newCustomerBasee
- =] newCustomerBase <Customer ... Potential LT » Customers
O Firm Customers _
D3eeding 0
[—» Segment
B Customers o D0, O Flow - Create CustomerBase. Seeding X
- -:ﬂ Parent <Segment> Initial Mame: |Seeding |
[—» SegmentID ntia
CUSTDI'_I'IEF Owner: |Create CustomerBase |
— Contact Rate Fraction
v Init Customers Units: ||:|E|:||:|IE |
0 Potential Customer Prevale.. = P
i Segment Share Init From Stock: | arent.Potential Customers |
= Potential Customers To Stock: |nEWCusb:umerBase-Cush:umers |
|:| Constant
4
lInitial Customer Fraction®*Parent.Potential Customers 46

Create CustomerBase Choose Set k
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6g. Finishing up

e We're almost done — we just need to define the triggers we left

empty

Error List

Source Description

® It’s easy to find them in the error Iist Zﬁ%Trigger"ChDDSE Segment” Missing Action to invoke |

[H] o

o o CustomerBase
by Fimm
Chobse Segment Count
Trigger - Firm.Choose Segment .
Mame: |Chl:u:|se Segment
Owner: |Firm » Counter
Seq. Mo.: |1 Counting
Wher: |Period Start
Trigger If:
CustomerBase by Firm.Count = 0
[ ] o
Action to Invoke:
(] o

Choose Segment] h

Create CustomerBase

i:i' Trigger "Create CustomerBase” Missing Action to invoke

Console Error List

Trigger - Choose Seagment. Create CustomerBase x

Mame: |Create CustomerBase |

Owner: |C|‘u:u:|se Segment |

Seq. Mo.: |1 >
When: | Mever
Trigger If:

true

Action to Invoke:

IrefSEgrf.ent.l:reate CustomerBase _ 47
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Done!

e New firms now enter the e You'll see some warnings due to
" ith lack of data for new firms — ignore,
market with customers or delete the computation

and profits

Customers

Source Description

I. Runtime [831]110/10/2018 - Nul reference customerbasedata in custornerbase[firm_0001|Lagagers] using "firrm_0001 |Lagger:

30000 i, Runtime [831] 10/10/2018 - Mull reference customerbasedata in customerbase[firm_0001|Laggers] using "“firm_0001 |Lagger:

300000

70000

Customerbaesellata

240000 Dats Customers

/ Faw

stomer
ance Time

210000

150000

pecple

150000

120000

0000

‘ - e firm_0001|Laggers : 51273646

=

2017 2013 2019 D‘I-,"DE

AO000

30000

1]
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EXTRA
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Attributes & References
SupplyChain8

o SupplyChainID identifies each level

e Customer and Supplier attributes identify each level’s partners
in the chain

e Special cases:
— The factory doesn’t have a supplier
— The Retailer has exogenous customer orders

 Modify the chain = add more data
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What if we wanted many-to-many supplier relationships?

e We'd need another Entity Type:
— Supply chain levels to manage stock, place orders, etc.

— Transactions to relate one level to another, keep track of orders and
shipments, etc.

Retaill #
Factory1l #
Retail2 #
Retail3
Transl Factoryl Retail2 #

Trans2 Factoryl Retail3 #
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Why do we need another entitytype for the relationship?

e There are two “"things” at work:

— The supply chain level: a self-contained firm, with inventory, staff,
financials, etc.

— The relationship between supply chain levels, with orders and
shipments from a level to a level

e In arrayed SD, you would notice that the firms have [level]
detail, while the relationships have [fromLevel, toLevel] detalil.

 In a database, you would link a firm table to a relationship table
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